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Instant VR

[image: ../_images/LW_Showcase.jpg]

Note


	LUX Walker Instant 3D to VR Automated workflow tool.

	Convert your 3D model to VR, interact and collaborate. Make faster design decisions, present your work.










Automated Workflow


Note


	LUX WALKER [https://www.luxwalker.com/] is meant to be as simple as possible.

	We Geolocate your model, carry across your layers, import your cameras and views and we convert your texture maps to realistic digital materials.







This allows you to review your design quickly without worrying about model setup.

[image: ../_images/3dtools.jpg]
Because we keep all the complexities in the back of this simplified workfow, most of your work stays in your modeling program. We offer support for many tools and with OBJ support you can export from the others.




Easy Collaboration

[image: ../_images/feats.jpg]

Note


	LUX WALKER [https://www.luxwalker.com/] has been developed as a real-time visualization tool to improve workflow and reduce communication errors.

	Join multiple people in a virtual building, collaborate with your team members throughout design development and present your final design to clients, from anywhere in the world.





Just send them .WALK export.






Typical Workflow

Typically LUX Walker is used like so:


Export your 3D Model

[image: ../_images/export_min.gif]

Note


	First, you need to export your 3D model so we can view it in LUX Walker.

	We have exporters for various 3D tools, and support .OBJ files for advanced users.









	Exporting to LUX Walker
	3Ds Max Export

	Blender .WALK Plugin

	Revit  .WALK Addin

	Rhino .WALK Plugin

	Sketchup .WALK Plugin

	OBJ Export












Run LUX Walker


Note


	Second, you need to load this export into LUX Walker.

	LUX Walker will load most files, but VR has a limit to the amount of geometry you can run smoothly. Contact Support if you have any problems.









	Quick Start

	Step into VR

	Share a .WALK Project








Fix any Materials

[image: ../_images/material_min.gif]

Note


	Our conversion process aims to generate realistic materials from your provided materials and texture maps.

	In some cases this might result in incorrect materials. Our Material tool allows you to easily switch between various types of materials or choose from a growing
library of built in materials.










Highlight any issues

[image: ../_images/draw_min.gif]

Note

We offer Markup and Measurement tools



DRAW TOOL




Add Context or Panorama

[image: ../_images/panorama_min.gif]

Note


	Context Immediately makes a project more immersive and can help solve problems earlier in the design process.

	You can add context using the Terrain Toggle in the Environment Tool. Or add a panorama to the project using the Panorama Tool







PANORAMA TOOL GOES HERE




Add Vegetation and detail items.

[image: ../_images/vegetation_min.gif]

Warning


	Complex 3D items will slow down your VR Experience.

	LUX Walker includes a large library of detail items and vegetation. Use these wherever possible.







VEGETATION AND ITEMS HERE




Save your File

[image: using/images/lw_save.jpg]

Note


	Closing LUX Walker will ask you if you want to Save your File.

	You can also save from the Menu Panel in VR or by clicking the Home Button on the desktop using the Mouse.







[image: using/images/lw_save_alt.jpg]



Capture some Images

[image: ../_images/render_min.gif]

Note

Images of up to 4K can be saved.



RENDER TOOL

SAVE FILE




Relink a new Export

[image: ../_images/lh_3.jpg]

Note

Keep LUX Walker changes and Reload a new Model

This allows you to Merge data from an old file using LUX Home.






Share a File

[image: ../_images/multiuser_alt_min.gif]
Send a .WALK file to collaborators
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Exporting to LUX Walker

[image: ../_images/3dtools.jpg]
Plugins for various 3D tools export a .WALK file which can be opened in LUX Walker.
See below for more information using your favorite tool.


Exporting from 3Ds Max


	3Ds Max Export
	Project Information - 3Ds Max

	Model Preparation - 3Ds Max

	Exporting a .WALK File

	FAQ - 3Ds Max










Exporting from Blender


	Blender .WALK Plugin
	Project Information - Blender

	Model Preparation - Blender

	Exporting a .WALK File

	FAQ - Blender










Exporting from Revit


	Revit  .WALK Addin
	Project Information

	Model Preparation

	Export Process

	FAQ - Revit










Exporting from Rhino


	Rhino .WALK Plugin
	Project Information - Rhino

	Model Preparation - Rhino

	Exporting a .WALK File

	FAQ - Rhino










Exporting from Sketchup


	Sketchup .WALK Plugin
	Project Information - SKP

	Model Preparation - SKP

	Exporting a .WALK File

	FAQ - SKP










Packaging OBJ Files


	OBJ Export
	Project Information - OBJ

	Model Preparation - OBJ

	Creating a .WALK File
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3Ds Max Export

Convert your 3ds Max model to a fully immersive true-to-life scale virtual reality model, instantly.


Note

Ensure that your materials are set to the default materials in 3Ds Studio Max. And that your export units result in 1 Unit = 1 Meter. This might mean changing the global units in the file.




Project Information - 3Ds Max


Warning

Unfortunately we are not yet able to extract gps information from your 3Ds Max file.






Model Preparation - 3Ds Max


Note

Please make sure your model is as clean as possible to ensure best performance.
When in doubt pro-optimize






Exporting a .WALK File


Note

The Exporter will export everything that is visible in the view. Please hide objects and layers that does not require exporting.




	Export from the File>Export Menu.




Export your file as an .OBJ

[image: ../_images/ObjExport.png]

	Select the high-lighted .OBJ Export options




[image: ../_images/MapSettings.png]
Continue Here:

OBJ Export

Enjoy your WALK

.




FAQ - 3Ds Max


	XXX:





xxx





	XXX:





xxx
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Blender .WALK Plugin

Instantly convert files from Blender to VR. Explore a fully immersive true-to-life scale model in LUX Walker.


Note

Please install the Export Plugin in order to export to .WALK files from Blender.

Step 1: Go to File>User Preferences in Blender.

[image: ../_images/Blender_Step1.png]
Step 2: Select Add-ons and click on Install from File….

[image: ../_images/Blender_Step2.png]
Step 3: Navigate to C:ProgramDataTenebris LabPluginsBlenderand select the io_export_LUXWALKER.py file.

[image: ../_images/Blender_Step3.png]
Step 4: Enable the .WALK Add-on

[image: ../_images/Blender_Step4.png]



You are now ready to export to LUX Walker.




Project Information - Blender


Warning

Unfortunately we are not yet able to extract gps information from your blender file.






Model Preparation - Blender


Note

Please make sure your model is as clean as possible to ensure best performance.






Exporting a .WALK File


Note

The Exporter will export everything that is visible in the view. Please hide objects and layers that does not require exporting.




	Export from the File>Export Menu.




[image: ../_images/Blender_Export.png]

	Find the .WALK file in the same folder as your Blend file.


	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




Enjoy your WALK

.




FAQ - Blender


	XXX:





xxx





	XXX:





xxx
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Revit  .WALK Addin

[image: ../_images/exporter.jpg]
Our Revit plugin is compatible with Revit 2018-2020 and makes exporting your projects simple yet highly customizable.


Project Information


Note

Your project location and project North will be imported along with any selected cameras.






Model Preparation


Note

Please make sure your model is as clean as possible to ensure best performance.




Exporting from Revit


	Content Preparation
	Location and Model Info





	Optimize your model
	Unnecessary Elements and Categories

	View Distance

	Complex Geometry and Detail





	Common Issues








Export Process


Note

The Exporter will export anything that is visible in the view. Please disable anything that does not require discussion.





	Exporting Steps

	Export Window Settings

	Versioning

	Optimize








FAQ - Revit


Note

LUX Walker is slow:

Reduce geometry quality using the quality slider.
and Remove unused details and objects from the export view.




Note

Material Transfer:

Materials are not correct in LUX Walker.
Ensure the material settings are correct in Revit. Materials with fade and tint will export these settings to LUX Walker.
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Content Preparation


Location and Model Info

[image: ../../_images/location.jpg]

Note

Lux Walker imports your location information from your Revit file. This allows for correct lighting and seasonal conditions for your project.



To do this you need to correctly set up your projects location and project north within your Revit project.



	In Revit Click:  Manage tab>Project Location panel> Location.


	In the Location Weather and Site dialog, click the Location tab.


	Specify the project location using one of these methods:






	Default City List:


	Nearest major city. For City, select a city from the list.










The corresponding Latitude, Longitude, and Time Zone values are displayed.

Exact location. Enter values for Latitude and Longitude.

Internet Mapping Service: For Project Address, enter the street address, city and state, or latitude and longitude of the project, and click Search.


Warning

Please ensure your True North is correctly set up so that sun angles are correct in LUX Walker.



[image: ../../_images/truenorth.jpg]











Optimize your model


Note

When exporting to VR keep in mind that it needs to run as fast as possible so that the user does not experience motion sickness.
Too many digital lines and geometries will slow down the project.




	Hide elements and categories not required for discussion.


	Limit your view distance.


	Remove Complex Geometry and Unnecessary Detail.


	Create a section box around what you would like to showcase.


	Have a less detailed master plan


	Section box areas or parts of the project with more detail.


	Use objects and Vegetation from the LUX Walker Library.











Unnecessary Elements and Categories

Each category in Revit is exported as a Layer to LUX Walker.
LUX Walker includes a library of items and entourage.


Note

Please disable items, families, categories and elements you do not need to see in VR.

Categories like:
Massing, Entourage, Planting
Can also be problematic, and can be replaced with LUX Walker items.












View Distance

Rendering distance has a massive impact on performance in LUX Walker. The panorama tool allows you to load in a panorama which you can use to create realistic context for your buildings. LUX Walker can also import context model around your site.
Keep your projects and site extents as small as possible.


Note

If you absolutely need to load in a large 3D site model make sure you section box so your building is as close to the centre as possible.




Warning

If you do not section box do this you might have problems finding your project when LUX Walker has loaded.



[image: ../../_images/siteplan_incorrect.jpg]

Warning

Please ensure that your survey points and base points are correctly set up. If they are too far apart your file will appear empty.
In the above example the survey point was thousands of units away from the model center.

[image: ../../_images/siteplan_correct.jpg]











Complex Geometry and Detail


Warning

Small and highly detailed items can cause slowdowns and issues with rendering in VR



When in doubt or the project runs slowly switch to wireframe view in Revit and inspect the file for complex objects. Anything that appears solid from a distance in wireframe mode can cause issues and slow downs. Use items from LUX Walker library where possible.

[image: ../../_images/WireFrame.png]







Section Box and Model Variations

You can the create a section box to crop your export. LUX Walker will download a large terrain around your project so use Revit topography sparingly or crop as close to project as needed.

[image: ../../_images/sectionbox.jpg]

Note

You can enable and disable linked files in your layer tool in LUX Walker. You can use this to your advantage by:
Linking in two different variations of a project into a new Revit Project and switching between them using the layer panel.



[image: ../../_images/visibility.jpg]









Large Projects

When dealing with large projects with may units/structures/spaces to show export the project as different files.

[image: ../../_images/largeprojects.jpg]

Note


	We recommend making different exports:

	
	Export a masterplan .WALK file without any furniture or details. Please make sure these elements are also off in your Linked Revit Files.


	Create detail section box models of rooms or parts of the building.










This allows you to explore and discuss the project at various scales instead of focusing on micro details when macro elements are being discussed.










Items and Vegetation


Using LUX Walker detail items and vegetation will increase performance and make the experience faster and more realistic.





Note


	CAD imports and Complex Items in Revit are problematic. Items like:

	Pillows, 3D Fire and smooth furniture items and CAD cars will cause slowdowns.








Note


	LUX Walker’s library includes pillows, bottles, glasses, books, cars, plates and vases and many more.

	These items have been added to the library to reduce the impact on performance and give the user a better experience in VR.
















Material Transfer

[image: ../../_images/materialbrowser.jpg]

Note

Textures assigned to the Generic Slot in Revit will be exported along with color and transparency information.



[image: ../../_images/renderappearance.jpg]

Warning

If Use Render appearance is unchecked Color will be exported from here.




Note


	LUX Walker will automatically convert your Revit materials to something more realistic.

	Keep in mind that all your settings will transfer including tint and fade settings.
This means if you fade a material so it looks better in a Revit view it will come in as transparent in LUX Walker.




















Common Issues


	LUX Walker is slow:

	Reduce geometry quality using the quality slider.
Remove unused details and objects from the export view.






Note

You can usually tell by the .WALK file whether it will be slow. Files over 200MB quickly get very slow.




	Materials are not correct in LUX Walker:

	Ensure the material settings are correct in Revit. Materials with fade and tint will export these settings to LUX Walker.






Note

If you have told Revit to use render appearance then the render appearance will be exported to LUX Walker. Please also inspect your fade and color assignments as they also carry over.
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Exporting Steps


	Open a project in Revit that you wish to export for VR Walkthrough.


	Open The Default 3D View OR Choose an existing 3D View


	Select the Add-Ins tab inside of Revit.




[image: ../../_images/RVT_EXP_0.png]

	Click the Export Lux Walker button on the Tenebris Lab section.




[image: ../../_images/RVT_EXP_1.png]

	Click Change to change the location of the export.




[image: ../../_images/RVT_EXP_2.png]

	Type in the File Name for your project, then click Export to start the export process.




[image: ../../_images/RVT_EXP_3.png]

	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




[image: ../../_images/RVT_EXP_4.png]
Enjoy your WALK










Export Window Settings

[image: ../../_images/exporter2.jpg]

Add Date:

Appends a date to your filename for easy versioning.




Export Quality

This limits the amount of geometry exported to LUX Walker.
A value of 6 is generally good enough for VR. Higher values will mean LUX Walker will be slower.
Optimize




Views to Export

This allows you to choose camera views to export to LUX Walker for quicker navigation in the Render tool.




Optimized Export

Optimizes your file. Might increase loading time, but greatly improves comfort in LUX Walker.
Has been removed in newest exporter.




Run in LUX Walker

If LUX Walker is installed on your PC this will open the file after exporting.












Versioning

Export a new file or use the “Add Date” export option to create versions of a project.
Please note: You cannot use multi user walk through mode with different versions of a project.


Design Options

Create a new Master File. Link in Option 1 and Option 2.
In LUX Walker use the layer tool to disable and enable design options.












Optimize


Note

LUX Walker can optimize your export by lowering the value in the Export Quality slider.



This reduces geometry count which in turn speeds up LUX Walker.
It has some side effects such as reducing the edges of round objects making them appear more geometric in shape.
If you absolutely need to see something at the highest detail, export a “section box” of only the items/room in question and increase the slider to the maximum value.

For Large projects we recommend exporting the whole project at 5 or below, then exporting section boxes of areas within the project at a higher quality.

This adds the benefit of limiting discussion around a specific part of a project and not getting lost in undeveloped areas.
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Rhino .WALK Plugin

Rhino to VR. Instantly convert your Rhino model in to a fully immersive true-to-life scale design model, with LUX Walker.


Note

First you need to install the plugin for Rhino.


	Download the Latest Rhino plugin from here [https://tenebrislab.com/wp-content/uploads/LWPlugins/Rhino/Export%20To%20LUX%20Walker.rhi].


	Double click the downloaded file (Export To LUX Walker.rhi) to install the Plugin to export to LUX Walker.




You might have to reload Rhino if it was open during installation of the plugin.




Project Information - Rhino

Setting up the Sun correctly in Rhino ensures correct location info is transferred to LUX Walker.


Note

Go to the pulldown menu Panels and open the Sun panel

[image: ../_images/0_Sun.jpg]
This will give you access to the correct simulation of the sun position

[image: ../_images/1_Sun.jpg]
In the sun menu:


	The sun option has to be activated


	The North direction has to be set to your offset, if any, in degrees. This will orient the north correctly with your scene




[image: ../_images/2_Sun.jpg]

	The last setting is the location. The nearest location can be selected from the list or by clicking Here the location is set based on the location of the laptop. With these settings the sun will be positioned correctly in LUX Walker.









Model Preparation - Rhino

Please make sure your model is as clean as possible to ensure best performance.




Exporting a .WALK File


Note

The Exporter will export everything that is visible in the view. Please hide objects and layers that does not require exporting.



[image: ../_images/Command[1].jpg]

	Run the command LUXWALKER in Rhino.




Optionally enable the Tenebris Lab toolbar.

[image: ../_images/EnablePlugin[1].jpg]

	Find the .WALK file in the same folder as your Rhino file.


	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




Enjoy your WALK

.




FAQ - Rhino


	XXX:





xxx





	XXX:





xxx
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Sketchup .WALK Plugin

[image: ../_images/SKP_EXP_3.png]
Our Sketchup plugin is compatible with Sketchup 2015-2019.


Note

You can export from any other version using the OBJ Export Method










Project Information - SKP


Note

Your project coordinates will be exported to LUX Walker as well as any views you have set up.



[image: ../_images/geolocate.jpg]
Go to Window > Model Info > Geo-location and click Add Location

Ensure your project is orientated correctly in Sketchup if you want the correct context and shadows.










Model Preparation - SKP


Note

Please make sure your model is as clean as possible to ensure best performance.



[image: ../_images/enabletoolbar.jpg]
You can right click on the toolbar area to enable the LUX Walker toolset.


Note

Correct layer management in Sketchup will ensure less issues down the road.

[image: ../_images/toolbar.jpg]
Included in the toolset is a simple button to setup your project with correct layers.

You can then Right click on a group or component and Click LUX WALKER - Put On Layer > LAYER

[image: ../_images/layers.jpg]
This will put all object and geometry nested in the group or component onto the selected LAYER.




Note

Switch to wireframe mode and remove complex and small items.

[image: ../_images/WireFrame1.png]


Please disable items, groups, components and layers you do not need to see in VR.
It is sometimes best to purge your file before export.  - Make a backup before purging.

LUX Walker includes a library of items and entourage that you can use in your projects.


Note

We recommend running Cleanup 3 for Sketchup [https://extensions.sketchup.com/en/content/cleanup%C2%B3]. to clean unnecessary items. It has built in purge functionality.












Exporting a .WALK File


Note

The Exporter will export everything that is visible in the view. Please hide objects and layers that does not require exporting.


	Open a Sketchup project that you wish to export for VR Walkthrough.


	Enable the Tenebris Lab Plugins to export to LUX Walker.




[image: ../_images/SKP_EXP_0.jpg]

	Save your file and Click the Export Lux button on the Tenebris Lab section.




[image: ../_images/SKP_EXP_1.jpg]

	Choose a folder you wish to export your .WALK file into.




[image: ../_images/SKP_EXP_2.png]

	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




[image: ../_images/SKP_EXP_3.png]


Enjoy your WALK










FAQ - SKP


	It is taking forever to export my file:





Sketchup does not like complex geometry. Please cleanup your model and removed unused items. We recommend running Cleanup 3 for Sketchup [https://extensions.sketchup.com/en/content/cleanup%C2%B3]. to clean unnecessary items
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OBJ Export

LUX Walker is compatible with .OBJ files exported from your favorite 3D modeling software.
We have imported files successfully from:
Archicad
Cinema4d
3Ds Max
Blender
Sketchup


Project Information - OBJ

Unfortunately we are not yet able to automatically insert gps information into your file.
Please import your model into Sketchup or Revit and export from there to have accurate gps locations.


Note

Need Help?

Contact us if you know how to edit an ini file…






Model Preparation - OBJ

Please make sure your model is as clean as possible with the least amount of geometry you can show to ensure best performance.


Note

You may be able to load much larger files if you split your model into more exported files - by category perhaps.
Smooth and round objects will cause issues. If possible reduce triangle count as much as possible.






Creating a .WALK File

Step 1: Create a folder and export your .OBJ to this folder. Make sure all textures are in a folder.


Note

You can have multiple .OBJ and .MTL files from different modelling programs as long as they all share the same origin and scale.



[image: ../_images/Step_1_Folder.jpg]
Step 2: Open “LUX Home” click on the + icon

[image: ../_images/Step_2_FolderToHome.jpg]
Step 3: Drag the folder containing the .OBJ to LUX Home.

[image: ../_images/Step_3_Drag.jpg]
Step 4: A .WALK file will be generated next to your export folder.

[image: ../_images/Step_4_WALK.jpg]

	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




Enjoy your WALK
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Quick Start


Note

We recommend following the Tutorial available from the Home scene in LUX Walker.










Home

[image: ../_images/home.jpg]

	Select and choose project to load. (.WALK Files) – Opens file browser.


	Click to enable multi user experience. See Multiplayer settings below.


	Click to launch in VR.




[image: ../_images/tutorial.jpg]

	Choose help to access tutorial and other options.





Note

The Tutorial will guide you in using LUX Walker and its Menu, but will not expose you to all tools.






Using your VR Controllers

[image: ../_images/Menu.jpg]
LUX Walker offers an intuitive help system and menu panel. Review the tools and help features that can be found when using LUX Walker application.






Step into VR

Included from the LUX Walker home scene is a Tutorial level which will get you familiar with the LUX Walker interface and using its tools in VR.
For your convenience the tools and features are listed below








Mini Model

[image: ../_images/LW_0_MiniModel.jpg]
View a scale model of your project. Teleport to any location on the map. Simply point and aim the controller at the desired location while holding down on the touchpad button.
The teleport indicator will appear now release the button to teleport to that location.

When in Mini Model you can squeeze both grip buttons and move both controllers apart to zoom in or move them together to zoom out. You can also rotate the model like this.

Use one grip and controller to move the model.










Time Tool

[image: ../_images/LW_1_TimeTool.jpg]

	Time Tool Icon — Click on this icon to access the time tool and the settings for the time tool.


	Change the time of day with the suns correct geolocation. Drag the sliders handle icon left or right to change the time of day.


	Select a custom date from the calendar.


	Tabs can be used to select a season.


	Displays the geolocation in the world.













Layer Tool

[image: ../_images/LW_2_LayerTool.jpg]

	Layers Tool Icon — Click on this icon to access the layers for the project.


	Manage Layers Window — Access all the layers and show and hide them by clicking on the yellow box on the left hand side of the layer.


	Show/Hide all layers — The top icon activates all layers, while the bottom icon de-activates the layers.













Environment Tool

XXXXXX










Panorama Tool

XXXXXX










Render Tool

[image: ../_images/LW_4_RenderTool.jpg]

	Zoom — Use this slider to adjust how zoomed the view for your render is. Alternatively, use the touchpad in your non-laser hand to zoom in and out.


	Time of day — Slide to change the time of day.


	Presets — Contains a list of your preset camera settings.


	Saturation/Contrast and Temperature/Exposure — Move this icon across your viewer to adjust the saturation/contrast and temperature/exposure of your view.


	Settings — Clicking on this icon will open a menu containing resolution and quality settings.


	Add Preset — Use this button to add a preset with current camera settings.


	Filter Amount Slider — Use this slider to adjust how much the filter applies to the view


	Grid Mode — Toggles a grid over your view.


	Panorama Mode — Sets the view to panorama mode which will render a 360 image while active.


	Filter Toggle — Toggles if the filter is active or not.


	Filter List — Shows a list of the filters.













Placement Tool

[image: ../_images/LW_5_PlacementTool.jpg]

	Placement Tool Icon — Click on this icon to access the placement tool and the settings for the placement tool.


	Navigation Tabs — Use this to navigate between different tabs for various object types.


	Displays the current selected object.


	Toggles multiple placement on/off.


	Toggle upright snap on/off when placing objects.


	Toggles random scale on/off for the current selected object.


	Toggles between placement and deletion of placed objects.













Material Tool

XXXXXX










Annotation Tool

[image: ../_images/LW_7_AnnotationTool.jpg]

	Annotation Tool Icon — Click on this icon to access the annotation tool and the settings for the annotation tool.


	Distance Draw — Click on this icon to toggle distance draw on or off. If distance draw is off the annotation will not snap to objects.


	Layer Controls — use these buttons to clear or delete the corresponding layer.


	Layers — Select a layer to start making annotations on that layer.


	Assign and draw modes — Select the Assign icon to assign drawings to the selected layer and switch back to the draw mode to create drawings on the currently selected layer.













Measure Tool

[image: ../_images/LW_8_MeasureTool.jpg]

	Measure Tool Icon — Click on this icon to access the measure tool and the settings for the measure tool.


	Used to select a measure mode, this will influence the direction the measurement tool will measure in.


	Use the drop down box to select the unit you wish to measure in.


	Displays the measurement mode that is being used.


	The visual reference of the distance measured.


	Displays the distance between two surfaces.















Share a .WALK Project

[image: ../_images/multiuser_min.gif]

Note

As long as another user has LUX Walker you can share a file with them and step into the same world.










How To Multi-user LUX Walker walkthrough:


	Export your .WALK.


	Test your file in LUX Walker.


	Send the .WALK file to your collaborator – they need a copy of LUX Walker.


	Open the file on either PC’s.


	Enable Multi-User Mode.


	Click VR Mode icon.


	Open the file on the other PC.


	Enable Multi-User Mode.


	Click VR Mode icon.
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Virtual Reality

[image: ../_images/VRmodes.jpg]

Note

Our software is aimed at users with a VR Headset and motion controllers. It is compatible with both Oculus and Steam VR Devices.




Choosing your VR Headset

If you are going to use LUX Walker in Virtual Reality (VR) Mode, you will need a VR Headset - Head Mounted Display (HMD).

For users who want to set up multiple users in the same room or want full room-scale virtual reality we recommend the HTC Vive,
users who work alone at a desk or who want portability can use an Oculus Rift. Both are great devices and have advantages over another.


HTC Vive and Steam VR

The HTC Vive and the Valve Index is the best choice for users who want standing, room-scale virtual reality.
Offering much larger play space than the competitors.

Detailed product info here.

It is also the only way to get accurate multiple person tracking spaces.

We suggest wall mounting your HTC Vive base stations for the best experience or, for portable setups, mount them on tripods or light stands.

Running the HTC Vive requires a computer with powerful graphics capabilities. Refer to our  recommended specs to see if you need to upgrade your computer.




Oculus Rift

The Oculus Rift is a great choice for people who want to use VR at their desk or on the go.
It is quick to set up and very comfortable to use. However it requires 3 USB 3 Ports.

The Oculus Rift S is even easier as it does not require any extra sensors and only one USB 3 port.

Detailed product info here.

Running the Oculus Rift requires a computer with powerful graphics capabilities. Refer to our  System Requirements








System Requirements


Note

Our software is aimed at users with a VR Headset and motion controllers. It is compatible with both Oculus and Steam VR Devices.




	Virtual Reality requires a high-end computer aimed at rendering 3D computer graphics as fast as possible.

	If at anytime the experience is slow it will cause motion sickness and an uncomfortable experience in VR.






Warning

Please note even the most powerful machine will not run a badly optimized 3D model. Please follow our modeling guidelines outlined in the documentation.



Both Oculus and Valve have recommended system requirements that will work with many smaller projects.
For larger projects with more materials and for an overall better experience the requirements are a little higher.

See below for Minimum and Recommended system requirements.
For more information see budget section below on choosing the right pc and its importance on rendering speed.


Minimum Requirements:


Note


	OS 64-bit Windows 7, Windows 8.1, Windows 10


	PROCESSOR Intel i5 5th Gen (or equivalent)


	MEMORY 8GB


	GRAPHICS NVIDIA GeForce GTX 970 4GB+ (or equivalent)


	DIRECTX Version 11


	STORAGE 5GB available space









Recommended Requirements:


Note


	OS 64-bit Windows 7, Windows 8.1, Windows 10


	PROCESSOR Intel i7 6th Gen (or equivalent)


	MEMORY 16GB


	GRAPHICS NVIDIA GeForce GTX 980 8GB (or equivalent)


	DIRECTX Version 11


	STORAGE 5GB available space











Installation



	Go to https://www.tenebrislab.com/my-account and download LUX WALKER.


	Once downloaded, double click on the .exe to begin the installation process.
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Exporting to LUX Walker

[image: ../_images/3dtools.jpg]
Plugins for various 3D tools export a .WALK file which can be opened in LUX Walker.
See below for more information using your favorite tool.


Exporting from 3Ds Max


	3Ds Max Export
	Project Information - 3Ds Max

	Model Preparation - 3Ds Max

	Exporting a .WALK File

	FAQ - 3Ds Max










Exporting from Blender


	Blender .WALK Plugin
	Project Information - Blender

	Model Preparation - Blender

	Exporting a .WALK File

	FAQ - Blender










Exporting from Revit


	Revit  .WALK Addin
	Project Information

	Model Preparation

	Export Process

	FAQ - Revit










Exporting from Rhino


	Rhino .WALK Plugin
	Project Information - Rhino

	Model Preparation - Rhino

	Exporting a .WALK File

	FAQ - Rhino










Exporting from Sketchup


	Sketchup .WALK Plugin
	Project Information - SKP

	Model Preparation - SKP

	Exporting a .WALK File

	FAQ - SKP










Packaging OBJ Files


	OBJ Export
	Project Information - OBJ

	Model Preparation - OBJ

	Creating a .WALK File
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3Ds Max Export

Convert your 3ds Max model to a fully immersive true-to-life scale virtual reality model, instantly.


Note

Ensure that your materials are set to the default materials in 3Ds Studio Max. And that your export units result in 1 Unit = 1 Meter. This might mean changing the global units in the file.




Project Information - 3Ds Max


Warning

Unfortunately we are not yet able to extract gps information from your 3Ds Max file.






Model Preparation - 3Ds Max


Note

Please make sure your model is as clean as possible to ensure best performance.
When in doubt pro-optimize






Exporting a .WALK File


Note

The Exporter will export everything that is visible in the view. Please hide objects and layers that does not require exporting.




	Export from the File>Export Menu.




Export your file as an .OBJ

[image: ../_images/ObjExport.png]

	Select the high-lighted .OBJ Export options




[image: ../_images/MapSettings.png]
Continue Here:

OBJ Export

Enjoy your WALK

.




FAQ - 3Ds Max


	XXX:





xxx





	XXX:





xxx
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Blender .WALK Plugin

Instantly convert files from Blender to VR. Explore a fully immersive true-to-life scale model in LUX Walker.


Note

Please install the Export Plugin in order to export to .WALK files from Blender.

Step 1: Go to File>User Preferences in Blender.

[image: ../_images/Blender_Step1.png]
Step 2: Select Add-ons and click on Install from File….

[image: ../_images/Blender_Step2.png]
Step 3: Navigate to C:ProgramDataTenebris LabPluginsBlenderand select the io_export_LUXWALKER.py file.

[image: ../_images/Blender_Step3.png]
Step 4: Enable the .WALK Add-on

[image: ../_images/Blender_Step4.png]



You are now ready to export to LUX Walker.




Project Information - Blender


Warning

Unfortunately we are not yet able to extract gps information from your blender file.






Model Preparation - Blender


Note

Please make sure your model is as clean as possible to ensure best performance.






Exporting a .WALK File


Note

The Exporter will export everything that is visible in the view. Please hide objects and layers that does not require exporting.




	Export from the File>Export Menu.




[image: ../_images/Blender_Export.png]

	Find the .WALK file in the same folder as your Blend file.


	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




Enjoy your WALK

.




FAQ - Blender


	XXX:





xxx





	XXX:





xxx
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Revit  .WALK Addin

[image: ../_images/exporter.jpg]
Our Revit plugin is compatible with Revit 2018-2020 and makes exporting your projects simple yet highly customizable.


Project Information


Note

Your project location and project North will be imported along with any selected cameras.






Model Preparation


Note

Please make sure your model is as clean as possible to ensure best performance.




Exporting from Revit


	Content Preparation
	Location and Model Info





	Optimize your model
	Unnecessary Elements and Categories

	View Distance

	Complex Geometry and Detail





	Common Issues








Export Process


Note

The Exporter will export anything that is visible in the view. Please disable anything that does not require discussion.





	Exporting Steps

	Export Window Settings

	Versioning

	Optimize








FAQ - Revit


Note

LUX Walker is slow:

Reduce geometry quality using the quality slider.
and Remove unused details and objects from the export view.




Note

Material Transfer:

Materials are not correct in LUX Walker.
Ensure the material settings are correct in Revit. Materials with fade and tint will export these settings to LUX Walker.
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Content Preparation


Location and Model Info

[image: ../../_images/location.jpg]

Note

Lux Walker imports your location information from your Revit file. This allows for correct lighting and seasonal conditions for your project.



To do this you need to correctly set up your projects location and project north within your Revit project.



	In Revit Click:  Manage tab>Project Location panel> Location.


	In the Location Weather and Site dialog, click the Location tab.


	Specify the project location using one of these methods:






	Default City List:


	Nearest major city. For City, select a city from the list.










The corresponding Latitude, Longitude, and Time Zone values are displayed.

Exact location. Enter values for Latitude and Longitude.

Internet Mapping Service: For Project Address, enter the street address, city and state, or latitude and longitude of the project, and click Search.


Warning

Please ensure your True North is correctly set up so that sun angles are correct in LUX Walker.



[image: ../../_images/truenorth.jpg]











Optimize your model


Note

When exporting to VR keep in mind that it needs to run as fast as possible so that the user does not experience motion sickness.
Too many digital lines and geometries will slow down the project.




	Hide elements and categories not required for discussion.


	Limit your view distance.


	Remove Complex Geometry and Unnecessary Detail.


	Create a section box around what you would like to showcase.


	Have a less detailed master plan


	Section box areas or parts of the project with more detail.


	Use objects and Vegetation from the LUX Walker Library.











Unnecessary Elements and Categories

Each category in Revit is exported as a Layer to LUX Walker.
LUX Walker includes a library of items and entourage.


Note

Please disable items, families, categories and elements you do not need to see in VR.

Categories like:
Massing, Entourage, Planting
Can also be problematic, and can be replaced with LUX Walker items.












View Distance

Rendering distance has a massive impact on performance in LUX Walker. The panorama tool allows you to load in a panorama which you can use to create realistic context for your buildings. LUX Walker can also import context model around your site.
Keep your projects and site extents as small as possible.


Note

If you absolutely need to load in a large 3D site model make sure you section box so your building is as close to the centre as possible.




Warning

If you do not section box do this you might have problems finding your project when LUX Walker has loaded.



[image: ../../_images/siteplan_incorrect.jpg]

Warning

Please ensure that your survey points and base points are correctly set up. If they are too far apart your file will appear empty.
In the above example the survey point was thousands of units away from the model center.

[image: ../../_images/siteplan_correct.jpg]











Complex Geometry and Detail


Warning

Small and highly detailed items can cause slowdowns and issues with rendering in VR



When in doubt or the project runs slowly switch to wireframe view in Revit and inspect the file for complex objects. Anything that appears solid from a distance in wireframe mode can cause issues and slow downs. Use items from LUX Walker library where possible.

[image: ../../_images/WireFrame.png]







Section Box and Model Variations

You can the create a section box to crop your export. LUX Walker will download a large terrain around your project so use Revit topography sparingly or crop as close to project as needed.

[image: ../../_images/sectionbox.jpg]

Note

You can enable and disable linked files in your layer tool in LUX Walker. You can use this to your advantage by:
Linking in two different variations of a project into a new Revit Project and switching between them using the layer panel.



[image: ../../_images/visibility.jpg]









Large Projects

When dealing with large projects with may units/structures/spaces to show export the project as different files.

[image: ../../_images/largeprojects.jpg]

Note


	We recommend making different exports:

	
	Export a masterplan .WALK file without any furniture or details. Please make sure these elements are also off in your Linked Revit Files.


	Create detail section box models of rooms or parts of the building.










This allows you to explore and discuss the project at various scales instead of focusing on micro details when macro elements are being discussed.










Items and Vegetation


Using LUX Walker detail items and vegetation will increase performance and make the experience faster and more realistic.





Note


	CAD imports and Complex Items in Revit are problematic. Items like:

	Pillows, 3D Fire and smooth furniture items and CAD cars will cause slowdowns.








Note


	LUX Walker’s library includes pillows, bottles, glasses, books, cars, plates and vases and many more.

	These items have been added to the library to reduce the impact on performance and give the user a better experience in VR.
















Material Transfer

[image: ../../_images/materialbrowser.jpg]

Note

Textures assigned to the Generic Slot in Revit will be exported along with color and transparency information.



[image: ../../_images/renderappearance.jpg]

Warning

If Use Render appearance is unchecked Color will be exported from here.




Note


	LUX Walker will automatically convert your Revit materials to something more realistic.

	Keep in mind that all your settings will transfer including tint and fade settings.
This means if you fade a material so it looks better in a Revit view it will come in as transparent in LUX Walker.




















Common Issues


	LUX Walker is slow:

	Reduce geometry quality using the quality slider.
Remove unused details and objects from the export view.






Note

You can usually tell by the .WALK file whether it will be slow. Files over 200MB quickly get very slow.




	Materials are not correct in LUX Walker:

	Ensure the material settings are correct in Revit. Materials with fade and tint will export these settings to LUX Walker.






Note

If you have told Revit to use render appearance then the render appearance will be exported to LUX Walker. Please also inspect your fade and color assignments as they also carry over.
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Exporting Steps


	Open a project in Revit that you wish to export for VR Walkthrough.


	Open The Default 3D View OR Choose an existing 3D View


	Select the Add-Ins tab inside of Revit.




[image: ../../_images/RVT_EXP_0.png]

	Click the Export Lux Walker button on the Tenebris Lab section.




[image: ../../_images/RVT_EXP_1.png]

	Click Change to change the location of the export.




[image: ../../_images/RVT_EXP_2.png]

	Type in the File Name for your project, then click Export to start the export process.




[image: ../../_images/RVT_EXP_3.png]

	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




[image: ../../_images/RVT_EXP_4.png]
Enjoy your WALK










Export Window Settings

[image: ../../_images/exporter2.jpg]

Add Date:

Appends a date to your filename for easy versioning.




Export Quality

This limits the amount of geometry exported to LUX Walker.
A value of 6 is generally good enough for VR. Higher values will mean LUX Walker will be slower.
Optimize




Views to Export

This allows you to choose camera views to export to LUX Walker for quicker navigation in the Render tool.




Optimized Export

Optimizes your file. Might increase loading time, but greatly improves comfort in LUX Walker.
Has been removed in newest exporter.




Run in LUX Walker

If LUX Walker is installed on your PC this will open the file after exporting.












Versioning

Export a new file or use the “Add Date” export option to create versions of a project.
Please note: You cannot use multi user walk through mode with different versions of a project.


Design Options

Create a new Master File. Link in Option 1 and Option 2.
In LUX Walker use the layer tool to disable and enable design options.












Optimize


Note

LUX Walker can optimize your export by lowering the value in the Export Quality slider.



This reduces geometry count which in turn speeds up LUX Walker.
It has some side effects such as reducing the edges of round objects making them appear more geometric in shape.
If you absolutely need to see something at the highest detail, export a “section box” of only the items/room in question and increase the slider to the maximum value.

For Large projects we recommend exporting the whole project at 5 or below, then exporting section boxes of areas within the project at a higher quality.

This adds the benefit of limiting discussion around a specific part of a project and not getting lost in undeveloped areas.
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Rhino .WALK Plugin

Rhino to VR. Instantly convert your Rhino model in to a fully immersive true-to-life scale design model, with LUX Walker.


Note

First you need to install the plugin for Rhino.


	Download the Latest Rhino plugin from here [https://tenebrislab.com/wp-content/uploads/LWPlugins/Rhino/Export%20To%20LUX%20Walker.rhi].


	Double click the downloaded file (Export To LUX Walker.rhi) to install the Plugin to export to LUX Walker.




You might have to reload Rhino if it was open during installation of the plugin.




Project Information - Rhino

Setting up the Sun correctly in Rhino ensures correct location info is transferred to LUX Walker.


Note

Go to the pulldown menu Panels and open the Sun panel

[image: ../_images/0_Sun.jpg]
This will give you access to the correct simulation of the sun position

[image: ../_images/1_Sun.jpg]
In the sun menu:


	The sun option has to be activated


	The North direction has to be set to your offset, if any, in degrees. This will orient the north correctly with your scene




[image: ../_images/2_Sun.jpg]

	The last setting is the location. The nearest location can be selected from the list or by clicking Here the location is set based on the location of the laptop. With these settings the sun will be positioned correctly in LUX Walker.









Model Preparation - Rhino

Please make sure your model is as clean as possible to ensure best performance.




Exporting a .WALK File


Note

The Exporter will export everything that is visible in the view. Please hide objects and layers that does not require exporting.



[image: ../_images/Command[1].jpg]

	Run the command LUXWALKER in Rhino.




Optionally enable the Tenebris Lab toolbar.

[image: ../_images/EnablePlugin[1].jpg]

	Find the .WALK file in the same folder as your Rhino file.


	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




Enjoy your WALK

.




FAQ - Rhino


	XXX:





xxx





	XXX:





xxx
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Sketchup .WALK Plugin

[image: ../_images/SKP_EXP_3.png]
Our Sketchup plugin is compatible with Sketchup 2015-2019.


Note

You can export from any other version using the OBJ Export Method










Project Information - SKP


Note

Your project coordinates will be exported to LUX Walker as well as any views you have set up.



[image: ../_images/geolocate.jpg]
Go to Window > Model Info > Geo-location and click Add Location

Ensure your project is orientated correctly in Sketchup if you want the correct context and shadows.










Model Preparation - SKP


Note

Please make sure your model is as clean as possible to ensure best performance.



[image: ../_images/enabletoolbar.jpg]
You can right click on the toolbar area to enable the LUX Walker toolset.


Note

Correct layer management in Sketchup will ensure less issues down the road.

[image: ../_images/toolbar.jpg]
Included in the toolset is a simple button to setup your project with correct layers.

You can then Right click on a group or component and Click LUX WALKER - Put On Layer > LAYER

[image: ../_images/layers.jpg]
This will put all object and geometry nested in the group or component onto the selected LAYER.




Note

Switch to wireframe mode and remove complex and small items.

[image: ../_images/WireFrame1.png]


Please disable items, groups, components and layers you do not need to see in VR.
It is sometimes best to purge your file before export.  - Make a backup before purging.

LUX Walker includes a library of items and entourage that you can use in your projects.


Note

We recommend running Cleanup 3 for Sketchup [https://extensions.sketchup.com/en/content/cleanup%C2%B3]. to clean unnecessary items. It has built in purge functionality.












Exporting a .WALK File


Note

The Exporter will export everything that is visible in the view. Please hide objects and layers that does not require exporting.


	Open a Sketchup project that you wish to export for VR Walkthrough.


	Enable the Tenebris Lab Plugins to export to LUX Walker.




[image: ../_images/SKP_EXP_0.jpg]

	Save your file and Click the Export Lux button on the Tenebris Lab section.




[image: ../_images/SKP_EXP_1.jpg]

	Choose a folder you wish to export your .WALK file into.




[image: ../_images/SKP_EXP_2.png]

	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




[image: ../_images/SKP_EXP_3.png]


Enjoy your WALK










FAQ - SKP


	It is taking forever to export my file:





Sketchup does not like complex geometry. Please cleanup your model and removed unused items. We recommend running Cleanup 3 for Sketchup [https://extensions.sketchup.com/en/content/cleanup%C2%B3]. to clean unnecessary items
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OBJ Export

LUX Walker is compatible with .OBJ files exported from your favorite 3D modeling software.
We have imported files successfully from:
Archicad
Cinema4d
3Ds Max
Blender
Sketchup


Project Information - OBJ

Unfortunately we are not yet able to automatically insert gps information into your file.
Please import your model into Sketchup or Revit and export from there to have accurate gps locations.


Note

Need Help?

Contact us if you know how to edit an ini file…






Model Preparation - OBJ

Please make sure your model is as clean as possible with the least amount of geometry you can show to ensure best performance.


Note

You may be able to load much larger files if you split your model into more exported files - by category perhaps.
Smooth and round objects will cause issues. If possible reduce triangle count as much as possible.






Creating a .WALK File

Step 1: Create a folder and export your .OBJ to this folder. Make sure all textures are in a folder.


Note

You can have multiple .OBJ and .MTL files from different modelling programs as long as they all share the same origin and scale.



[image: ../_images/Step_1_Folder.jpg]
Step 2: Open “LUX Home” click on the + icon

[image: ../_images/Step_2_FolderToHome.jpg]
Step 3: Drag the folder containing the .OBJ to LUX Home.

[image: ../_images/Step_3_Drag.jpg]
Step 4: A .WALK file will be generated next to your export folder.

[image: ../_images/Step_4_WALK.jpg]

	Open the .WALK file in LUX Walker by double clicking or selecting in LUX Walker.




Enjoy your WALK
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Quick Start


Note

We recommend following the Tutorial available from the Home scene in LUX Walker.










Home

[image: ../_images/home.jpg]

	Select and choose project to load. (.WALK Files) – Opens file browser.


	Click to enable multi user experience. See Multiplayer settings below.


	Click to launch in VR.




[image: ../_images/tutorial.jpg]

	Choose help to access tutorial and other options.





Note

The Tutorial will guide you in using LUX Walker and its Menu, but will not expose you to all tools.






Using your VR Controllers

[image: ../_images/Menu.jpg]
LUX Walker offers an intuitive help system and menu panel. Review the tools and help features that can be found when using LUX Walker application.






Step into VR

Included from the LUX Walker home scene is a Tutorial level which will get you familiar with the LUX Walker interface and using its tools in VR.
For your convenience the tools and features are listed below








Mini Model

[image: ../_images/LW_0_MiniModel.jpg]
View a scale model of your project. Teleport to any location on the map. Simply point and aim the controller at the desired location while holding down on the touchpad button.
The teleport indicator will appear now release the button to teleport to that location.

When in Mini Model you can squeeze both grip buttons and move both controllers apart to zoom in or move them together to zoom out. You can also rotate the model like this.

Use one grip and controller to move the model.










Time Tool

[image: ../_images/LW_1_TimeTool.jpg]

	Time Tool Icon — Click on this icon to access the time tool and the settings for the time tool.


	Change the time of day with the suns correct geolocation. Drag the sliders handle icon left or right to change the time of day.


	Select a custom date from the calendar.


	Tabs can be used to select a season.


	Displays the geolocation in the world.













Layer Tool

[image: ../_images/LW_2_LayerTool.jpg]

	Layers Tool Icon — Click on this icon to access the layers for the project.


	Manage Layers Window — Access all the layers and show and hide them by clicking on the yellow box on the left hand side of the layer.


	Show/Hide all layers — The top icon activates all layers, while the bottom icon de-activates the layers.













Environment Tool

XXXXXX










Panorama Tool

XXXXXX










Render Tool

[image: ../_images/LW_4_RenderTool.jpg]

	Zoom — Use this slider to adjust how zoomed the view for your render is. Alternatively, use the touchpad in your non-laser hand to zoom in and out.


	Time of day — Slide to change the time of day.


	Presets — Contains a list of your preset camera settings.


	Saturation/Contrast and Temperature/Exposure — Move this icon across your viewer to adjust the saturation/contrast and temperature/exposure of your view.


	Settings — Clicking on this icon will open a menu containing resolution and quality settings.


	Add Preset — Use this button to add a preset with current camera settings.


	Filter Amount Slider — Use this slider to adjust how much the filter applies to the view


	Grid Mode — Toggles a grid over your view.


	Panorama Mode — Sets the view to panorama mode which will render a 360 image while active.


	Filter Toggle — Toggles if the filter is active or not.


	Filter List — Shows a list of the filters.













Placement Tool

[image: ../_images/LW_5_PlacementTool.jpg]

	Placement Tool Icon — Click on this icon to access the placement tool and the settings for the placement tool.


	Navigation Tabs — Use this to navigate between different tabs for various object types.


	Displays the current selected object.


	Toggles multiple placement on/off.


	Toggle upright snap on/off when placing objects.


	Toggles random scale on/off for the current selected object.


	Toggles between placement and deletion of placed objects.













Material Tool

XXXXXX










Annotation Tool

[image: ../_images/LW_7_AnnotationTool.jpg]

	Annotation Tool Icon — Click on this icon to access the annotation tool and the settings for the annotation tool.


	Distance Draw — Click on this icon to toggle distance draw on or off. If distance draw is off the annotation will not snap to objects.


	Layer Controls — use these buttons to clear or delete the corresponding layer.


	Layers — Select a layer to start making annotations on that layer.


	Assign and draw modes — Select the Assign icon to assign drawings to the selected layer and switch back to the draw mode to create drawings on the currently selected layer.













Measure Tool

[image: ../_images/LW_8_MeasureTool.jpg]

	Measure Tool Icon — Click on this icon to access the measure tool and the settings for the measure tool.


	Used to select a measure mode, this will influence the direction the measurement tool will measure in.


	Use the drop down box to select the unit you wish to measure in.


	Displays the measurement mode that is being used.


	The visual reference of the distance measured.


	Displays the distance between two surfaces.















Share a .WALK Project

[image: ../_images/multiuser_min.gif]

Note

As long as another user has LUX Walker you can share a file with them and step into the same world.










How To Multi-user LUX Walker walkthrough:


	Export your .WALK.


	Test your file in LUX Walker.


	Send the .WALK file to your collaborator – they need a copy of LUX Walker.


	Open the file on either PC’s.


	Enable Multi-User Mode.


	Click VR Mode icon.


	Open the file on the other PC.


	Enable Multi-User Mode.


	Click VR Mode icon.
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LUX Walker Settings

Some settings are only accessible using the mouse on the desktop.








Settings Panel

[image: ../_images/desktopmenuclosed.jpg]
[image: ../_images/desktopmenuopen.jpg]
[image: ../_images/menuadvanced.jpg]









Quality Options


	Quality Settings





Graphics Quality - Increases sharpness of objects at an increase to performance cost.
Vegetation Quality - Increases vegetation rendering distance at an increase to performance cost.
Advanced settings


Render Scale - Manually Increase sharpness of objects at an increase to performance cost.
Shadow Quality - Manually Increase shadow quality at an increase to performance cost.








	Lighting Settings





Global Light - Increase or decrease the environmental light contribution in the scene.


Advanced settings


Sampling Size - Increases the lighting contribution size at an increase to performance cost.
Sampling Size - Increases the lighting area that gets realistic lighting at an increase to performance cost.
Lighting Samples - Increases lighting quality at an increase to performance cost.











	Render Settings





Screenshot Size - Size of the Images captured by the spectator render camera.
Render Mode - Quality of the Render Mode spectator camera.













Panorama

LUX Walker allows you to load a panorama as onto a cylinder that renders behind other objects.


	Offset - Height offset from Horizon


	Radius - Radius of the Cylinder that holds the panorama.


	Rotation - Rotation of the Cylinder that holds the panorama.


	Scale - Scale of the Cylinder height that holds the panorama.


	Load Image - Load Panorama from hard drive.





Note

Combinations of Radius and Scale will allow you to get correct aspect ratios.

Removing the background in an image editing program and saving as a .PNG will blend the panorama with the background.












Multiplayer


	Lock Teleport - Sync teleport across networked users


	Lock Time - Sync time across networked users


	Room ID - Room information
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LUX Home

Manage projects with a view of your recent files  in LUX Home.


Overview

[image: ../_images/lh_0.jpg]

	Projects Tab


	Import/Link Tab


	Merge Tab


	Refresh Project Library


	Open Lux Walker


	Open Lux Navigate


	Settings Tab


	Open TenebrisLab.com







Projects Tab

[image: ../_images/lh_1.jpg]
View all your exported projects, select a project and open it in Lux Walker or open renders in Lux Navigate.


	Project Paths – Shows where the project files are located. Click to open folder in File Browser


	Version Selector – Choose which exported version of the project you would like to open


	Remove Project from Library. No files will be deleted.







Link Tab

[image: ../_images/lh_2.jpg]
Allows dragging and dropping a folder to convert it to a .WALK file. The folder needs .obj and .mtl files inside, as well as a folder containing your textures.

You can also drag in a .WALK file to add it to your library. This allows you to add projects located on a network drive, that may have been exported by someone else.




Merge Tab

[image: ../_images/lh_3.jpg]
Allows you to merge files between two .WALK files. If you have cameras, markup or vegetation in a project and you would like to add it to an updated export of the project you can use this tab to merge items between projects.


	Browse for the project file that contains the items you would like to add to another project.


	The project name and location will autofill once a project file is selected.


	Check which items you would like to be merged.


	Select the target project to which you wish to add the selected items.


	Click to commit merge and copy items to project.







Settings  Tab

[image: ../_images/lh_4.jpg]
Manages the linking between the various Lux Suite programs and Lux Home. Used to re-establish the links if they were lost.


	The current path to the selected program.


	Click to change the location of the selected program.
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FAQ


	Test


	Test2


	Test3


	Test4







Troubleshooting


Network Related Issues


Note

LUX Walker requires that you open TCP port 843 for multiplayer networking.



If you are experiencing any other issues you can try open the following ports.

TCP: 4530 4531 4533 9090 9091 9093

UP:  5055 5056 5057 5058

Fore more information see here: https://doc.photonengine.com/en-us/server/v3/reference/tcp-and-udp-port-numbers




License Issues


Stuck Linked License:


	Open LUX Walker on PC with linked license.


	Wait for Home Screen.


	Close LUX Walker







Unable to Register


	Check Internet connection.


	Restart PC.











Need Help?

If you have any further Questions, please contact support@tenebrislab.com





          

      

      

    

  

  
    
    EULA
    

    

    
 
  

    
      
          
            
  
EULA

END-USER LICENSE AGREEMENT FOR TENEBRIS LAB (PTY) LTD

This End-User License Agreement (EULA) is a legal agreement between you (either an individual or a single entity) and the mentioned author (Tenebris Lab (Pty) Ltd) for the Tenebris Lab software that accompanies this EULA, which includes computer software and may include associated media, printed materials, and “online” or electronic documentation (“Software”).
By installing, copying, or otherwise using the Software, you agree to be bounded by the terms of this EULA.
If you do not agree to the terms of this EULA, do not install or use the Software.

DEFINITIONS:

Tenebris Lab is the Author of the Software.
LUX SUITE is a package comprising of LUX WALKER and LUX NAVIGATE.
Latest versions of our software can and should always be downloaded from  https://www.tenebrislab.com/my-account/
LUX “.VIEW, .NVGT and .WALK” Projects are file-types used by LUX WALKER and LUX NAVIGATE.

GRANT OF LICENSE:

This License allows you to:
Install and use LUX WALKER on multiple computers and make copies of LUX WALKER in Machine-readable form for backup purposes, provided the number of concurrent users does not exceed the number of LUX WALKER licenses purchased. You must reproduce on any such copies all copyright notices and any other proprietary legends on the original copy of LUX WALKER.  A copy of LUX WALKER must be purchased for each user.
Provide a copy of LUX WALKER to people outside your company in order to use the collaboration tools and viewing functions provided that the number of concurrent users does not exceed the number of LUX WALKER licenses owned.
Make copies of a LUX “.VIEW, .NVGT and . WALK” Projects, and distribute those copies for use by yourself, personnel employed by you, clients, or another party.

LICENSE RESTRICTIONS:

Other than as set forth under “Grant of License”, you may not make or distribute copies of LUX WALKER, or electronically transfer LUX WALKER from one computer to another or over a network. You may not rent, lease or sublicense LUX WALKER. You may not modify LUX WALKER or create derivative works based upon LUX WALKER.

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS:

Limitations on Reverse Engineering, Decompilation, Disassembly and change (add, delete or modify) the resources in the compiled the assembly. You may not reverse engineer, decompile, or disassemble the LUX WALKER, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.

HARDWARE REQUIREMENTS:

You are responsible for obtaining and supplying the hardware necessary to run LUX WALKER, and Licensor has no obligation to provide any hardware or support service for hardware.
LUX WALKER runs on a Windows operating system and needs internet access over HTTP to the license server of Tenebris Lab to run the professional version. You shall be responsible for selecting the right resources required and for ensuring that these are available in full and in a timely manner. Tenebris Lab shall under no circumstances be liable for losses or costs arising as a result of transmission errors, breakdowns or the non-availability of these facilities. To see  the hardware requirements please visit https://tenebrislab.com/documentation/hardware/specs/

UPDATE AND MAINTENANCE:

Tenebris Lab regularly releases updates and adds new features to LUX WALKER. Any major new feature may be liable to additional cost in the form of an upgrade or additional monthly fee.

PRIVACY:

By installing this copy of LUX WALKER you accept that LUX WALKER sends basic information like computer name and hardware specifications to Tenebris Lab servers with the purpose to verify use of your license.
By installing this copy of LUX WALKER you accept that LUX WALKER sends test results and hardware specifications to Tenebris Lab servers with the purpose to further improve future developments of our Software. This information will be used to create estimates of performance of different hardware and to improve hardware compatibility.
LUX WALKER uses a floating license system and licenses are activated/de-activated on the Tenebris Lab license servers. In order to maintain the activation status of  LUX WALKER licenses (active or inactive), Tenebris Lab stores activation/de-activation data in a database.
Tenebris Lab  also reserves the right to use this data for analytical purposes, such as usage statistics.

COPYRIGHT AND OWNERSHIP:

All title and copyrights in and to LUX WALKER (including but not limited to any images, libraries, and examples incorporated into LUX WALKER ), and any copies of the LUX WALKER are owned by Tenebris Lab. The LUX WALKER is protected by copyright laws and international treaty provisions. Therefore, you must treat the LUX WALKER like any other copyrighted material. The licensed users or licensed company can use all functions, libraries and symbols in the LUX WALKER to create new content and digital worlds.

BILLING:
RECURRING BILLING:

By starting a paid subscription package of LUX WALKER, LUX NAVIGATE or the LUX SUITE and providing a Payment Method, you authorize Tenebris Lab to charge you a subscription fee at the then current rate, and any other charges that may arise in connection with your use of Tenebris Lab Software to your Payment Method.
You acknowledge that the amount billed each period may vary for reasons that may include promotional offers, and/or changing a plan, and you authorize Tenebris Lab to charge your Payment Method for such varying amounts, which may be billed in one or more charges.
Tenebris Lab may change the pricing of its Software or components thereof in any way and at any time as Tenebris Lab may determine in our sole and absolute discretion. Tenebris Lab will provide notice via email or within Tenebris Lab software before any such price changes. If you do not wish to continue your subscription you may cancel in accordance to Termination provisions below.

BILLING CYCLE:

The subscription fee for the Tenebris Lab Software will be billed at the beginning of your paid subscription period and each month thereafter, unless and until you cancel your subscription or are still within the trial period. Tenebris Lab automatically bills your Payment Method each period on the calendar day corresponding to the to the commencement of your paid subscription.  Tenebris Lab reserves the right to change the timing of our billing as indicated below if your Payment Method has not successfully settled.  In the event your paid subscription began on a day not contained in a given month or year, Tenebris Lab will bill your Payment Method on an alternative day in the applicable month or year as Tenebris Labs deems appropriate.  For example, if you started a paid monthly subscription on January 31st, your next payment date is likely to be February 28th, and your Payment Method would be billed on that date. Tenebris Lab may authorize your Payment Method in anticipation of subscription or other changes.  As used in this Agreement, “billing” shall indicate a charge, debit or other payment clearance, as applicable, against your Payment Method.

REFUNDS:

Payments are NONREFUNDABLE and there are NO refunds for partally used billing cycles.

TAXES:

You shall be responsible for paying all applicable sales, use, transfer, or other taxes and all duties, whether national, state, or local, however designated, that are levied or imposed by reason of your paid use of the Software under this Agreement, excluding income taxes on the net profits of Tenebris Lab.  You shall reimburse Tenebris Lab for the amount of any such taxes or duties paid or incurred directly by Tenebris Lab as a result of such paid use, and you agree that Tenebris Lab may charge any such reimbursable taxes to your Payment Method.
Payment Methods: You may edit your Payment Method information by signing in to your account at https://tenebrislab.com/my-account/.  If a payment is not successfully settled, due to expiration, insufficient funds, or otherwise, and you do not edit your Payment Method information or downgrade or cancel your subscription, you remain responsible for any uncollected amounts and authorize Tenebris Lab to continue billing the Payment Method, as it may be updated.  This may result in a change to your payment billing dates.  For certain Payment Methods, the issuer of your Payment Method may charge you a foreign transaction fee or other charges.  Check with your Payment Method service provider for details.

TERMINATION:

Termination by Tenebris Lab: Without prejudice to any other rights, the Tenebris Lab may terminate this EULA if you fail to comply with the terms and conditions of this EULA. In such event, you must destroy all copies of the Tenebris Lab Software and all of its component parts. We, the Licensor reserves the right to terminate the service of subscription and will provide a 2 month notice to the Licensee regarding such termination.
Termination by You:  If at any time you want to cancel your subscription you may do so by visiting https://tenebrislab.com/my-account/. If you cancel your subscriptions, you have no further payment obligations to Tenebris Lab, but your usage rights and access to Tenebris Lab Software will be revoked. Your account will still be active on Tenebris Lab website and will not be removed unless you email support@tenebrislab.com and request full deletion of your account..

NO WARRANTIES:

Tenebris Lab expressly disclaims any warranty for Tenerbris Lab Software. The LUX WALKER and any related documentation is provided “as is” without warranty of any kind, either express or implied, including, without limitation, the implied warranties or merchantability, fitness for a particular purpose, or non-infringement. The entire risk arising out of use or performance of Tenerbris Lab Software remains with you.
NO LIABILITY FOR DAMAGES:
In no event shall the Tenebris Lab be liable for any special, consequential, incidental or indirect damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, physical or emotional harm caused as a result of the software, or any other pecuniary loss) arising out of the use of or inability to use this product, even if Tenebris Lab is aware of the possibility of such damages and known defects.
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